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Support and Resources

Get the support you need from Safe Software.

Training
Training courses on AVIE Desktop are offered by Safe Software and our reseller network.

Access training at http://www.safe.com/learning.

» Recorded: Take our full-length AMEtraining courses for free at your own pace. Each
course includes hours of instructional video from one of our trainers, hands-on exer-
cises with sample data, and a copy of the course manual.

« Live Online: Get live hands-on training from FME-certified trainers in our virtual
classroom. All of Safe Software's online courses include a virtual machine complete
with FMElicense, sample data, workspaces, and a copy of the course manual.

« In-Person: Browse a list of AMEtraining courses held in cities throughout the world.

Or, contact your Safe Software account manager or your FMEreseller to arrange a private

training course for your organization.

Downloads & Documentation

Access the latest AMEbetas, service packs, documentation and other helpful technical

resources.

Access FME Downloads

Access FME Documentation
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FME Community

The FME Community (https://community.safe.com/s/) is the online source for all inform-

ation on Safe Software products, including:

» Knowledge Base: Our library of authoritative how-to's, FAQs, demos, and more.

o Community Answers: Ask questions and get answers from our community of cus-
tomers and partners.

« ldeas Exchange: Help improve AME Suggest, vote, and comment on new features.

Support

We are happy to help. Msit https://community.safe.com/s/support for more information.

Live Chat/Leave a Message

Not able to find what you want?We are online or only a message away. On almost every
page at www.safe.com, you will see adialog that allows you to ask us a question.

Safe Software Partner Program

At Safe Software, we are enthusiastic about equipping people with tools and training. We
have several partnership programs designed to promote the development of RME skills
and extend FVIE's capabilities to suit your specific needs:

» Value-Added Resellers (VAR) Program: Represent an established brand in your region.

» Consultant Partner Program: Receive FMEtools and training that you can use to help
your clients.
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» Developer Partner Program: Obtain an FME development license to extend the tech-
nology to work within your own applications.
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Accessing Product Help

Hles

In-depth technical reference documentation is available on the safe.com website at

https://community.safe.com/s/documentation, and is also included with your

FMEinstallation.

By default, when Help is invoked from any AME Desktop tool (FMEWbrkbench, FME Data
Inspector, and others), it is opened from the safe.com website. This means that you will

always see the latest help topics for updates and for new features.

You can change this default behavior and access product documentation from the help

filesthat are installed locally (for example, if Internet access is unreliable or is not avail-

able).

To change the default help location

Start FIMEWbrkbench.

. On the menu bar, click Tools and select FME Options.

1
2
3. On the sidebar of the AME Options page, click Default Paths.
4

. Under "Documentation Help Locations," click the checkbox beside Use Offline

Help.
dick OK.
6. Restart FIMEWorkbench.

o1

Accessing Product Help Fles
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Getting Started and System
Requirements

Before You Begin

Before installing FIME Desktop, Safe Software recommends that you exit all programs,
and ensure that the installation directory has access permission for all FMEusers who
may log onto that computer.

In this Section

Prerequisites

You have system administrator privileges in the installation environment.

The installation environment must meet the minimum requirements listed on the

FME Desktop Technical Specifications.

If you have purchased FME Desktop, you will need:
o The FAMEDesktop installer. If you do not already have the installer, download it

from here.

« The Serial number or license file that was provided by Safe Software. To get your

serial number, see the confirmation e-mail you received after purchasing FME
Desktop.

If you are evaluating FME Desktop, obtain the FVIE Desktop Trial Installer. If you

require assistance after installing, contact fmetrial @safe.com.

Getting Sarted and System Requirements
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Other Requirements

Windows

Note: To install FMEon a server for use with athin-end client (for example, a
aitrix®installation), you must use an FMEfloating license. To install floating
licenses, you must be running a TCP/IP network.

Linux: Red Hat and CentOS

Check for Active Subscription (Red Hat Only)

FMEmay not be installed on a Red Hat instance unless it has an active subscription.
For more information:

o https://access.redhat.com/documentation/en-us/red hat subscription man-

agement/1/html/quick registration for rhel/

EPEL Package Repository

On Red Hat or CentOS, you must first download and install the Extra Package for
Enterprise Linux (EPE.) Community Project repository.

For more information:

o https://fedoraproject.org/wiki/BPH #How can | use these extra packages.3F

See also:

o http://www.rackspace.com/knowledge center/article/install-epel-and-addi-

tional-repositories-on-centos-and-red-hat

NumPy and Matplotlib

NumPy and Matplotlib must be installed, via pip and pip3. This may be done before
or after installing FVE
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Determining the FME License Type to Install

Safe Software offers flexible licensing options for FME

The type of license that you receive (fixed or floating) is determined at the time of your
request for evaluation or purchase.

Single-Hxed License

Asingle-fixed FMElicense (also known as node-locked or CRClicense) enables FMEto
work on a single specified computer. The AVIE Licensing Assistant generates a unique
registration key for that computer, which is used to create the license. If FMEis installed
on more than one computer, each computer requires its own license.

By default, all evaluation licenses are single-fixed, unless you specify otherwise.

We recommend using a floating license when installing FME on a virtual machine. Safe
Software may not provide updated license files if the registration key of the physical

machine is no longer valid due to frequent hardware changes. For more information, see
About Hoating Licenses.

o Installing Single-Fxed Licenses

Hoating License

Afloating license means that a single computer is provided with a number of licenses
and acts as a server by issuing these licenses to any other computer that requests one. A
floating license is a common way for a company to share a limited number of licenses
among its FME users.

AHexNet software license manager provides the floating license capability to FME The
HexNet software is installed on a computer that acts as a license server. Every time FME
Is started on a computer, the server issues alicense, provided there is one still available.
When a computer closes AVIE, that license is returned. For example, consider a five-seat
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floating license and 30 workstation computers. Each workstation has FMEinstalled. Any
workstation can run FME, but only a maximum of five at any one time.

To install FMEon a server for use with a thin-end client (for example a Gtrix/\WWinframe
installation), it is highly recommended that you use a floating license. Fixed licenses can
be used, but keep in mind that you will need a fixed license for each user who will be
making use of the software.

For failover purposes, there is an additional option to install an array of three licenses on
three separate servers.

For more information, see About Hoating Licenses.

Glossary of Terms

Activation

Associating a registration key with a single-fixed license, using the FME Licensing Assist-

ant.

Borrowing (a floating license)

If your FME Desktop product uses a floating license, and your organization supports this
option, a computer that will not be connected to the license server can borrow alicense
for offline use and run FME for a maximum of 30 days.

The computer must be connected to the license server at the time of borrowing.

Hoating License

Afloating license means that a single computer is provided with a number of licenses
and acts as a server by issuing these licenses to any other computer that requests one. A
floating license is acommon way for a company to share a limited number of licenses
among its FME users.
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Hoating License Manager

AHexNet software license manager provides the floating license capability to FME The
HexNet software is installed on a computer that acts as a license server. Bvery time FME
Is started on a computer, the server issues a license, provided there is one still available.
When a computer closes RV, that license is returned. For example, consider a five-seat
floating license and 30 workstation computers. Each workstation has FMEinstalled. Any
workstation can run FME, but only a maximum of five at any one time.

Grid Shift Hle

Grid shift files are used when reprojecting between coordinate systems that have dif-
ferent datums. FME supports conversions between coordinate systems using different
datums. Many datum transformations are not mathematically definable and require the
use of grid of shifts. If you attempt to make a datum transformation of this kind without
the appropriate grid shift file in place FMEwill abort the translation.

Single-Fixed License

Asingle-fixed FMElicense (also known as node-locked or CRClicense) enables FMEto
work on a single specified computer. The AVEE Licensing Assistant generates a unique
registration key for that computer, which is used to create the license. If FMEis installed
on more than one computer, each computer requires its own license.

Getting Sarted and System Requirements 16



Installing FME Desktop

Installing FIME Desktop on Microsoft Windows

1
2.

3.
4.

If you downloaded FME from www.safe.com, double-click the downloaded file.

On the AVIE Desktop Installation Extractor dialog, specify a Destination folder in
which to extract installation files. Note that this folder only specifies where install-
ation files are extracted—it does not specify where FME Desktop program files are
installed. That location is specified later in the installer.

Tip: Take note of the specified Destination folder location. Following install-
ation, you may wish to:
» Review the installation .log file

» Remove these files to save disk space.

dick Install.

When extraction is complete, the installer opens. On the Welcome to AVIE Desktop
screen, click Next.

Follow the instructionsin the installation wizard.

Bxpress or Qustom Install?

The RAVE Desktop installer gives you the option of an Express or Qustom install-
ation. If you choose Express, the following installation settings are configured auto-
matically. If you choose Qustom, the installer gives you the option of configuring
each setting separately.

Installing AME Desktop 17
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Setting Description Value in
Express
Install

Associate AVE Whether to associate AIME Desktop with its supported file Yes
with the sup- formats, which enables Windows Explorer right-click

ported file functionality to open, view, translate, and transform files
formats using FME Desktop.

Install Python Whether to include an optional Python 2.7 interpreter No
2.7 with the installation. (APython 3.7 interpreter is
installed by default.)

WARNING: The Python 2.7 interpreter relies on the
Misual Studio 2008 runtime, which has security vul-
nerabilities. If you have existing FME Desktop work-
spaces that reference Python 2.7, we strongly
recommend upgrading them to reference Python 3.x

in lieu of installing the Python 2.7 interpreter.

Install Soft-  Whether to install the SDK, which provides access to No
ware Devel-  FMEObjects and FMEPlug-in Builder APIs. You can use
opment Kit the APIsto create your own applications and plug-ins

that make use of FMEfunctionality.

Implicit Whether implicit NAD27 to NAD83 datum shifts use Cana- None
NAD27 <-> dian or U.S. grid shift files. If None, FME prompts for a
NAD83 Datum selection at workspace runtime.

Sl Note: You can change this setting after installation
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Setting Description Value in
Express
Install

in the FME Options menu. For more information, see
Coordinate Systems.

6. When FMEis finished installing, the Licensing Assistant starts.

Installing FIME Desktop from the Windows Com-
mand Prompt

We recommend installing FME Desktop using the installation wizard. However, installing
from the command prompt may be useful when you want to perform asilent or remote

installation.

About the Installer

The RAMVE Desktop installer is a self-extracting executable from which you can directly call
an installer package (MSl) in a single command. Alternatively, you can manually extract
installation files, then call the MSI file to silently install.

Note: Acommand prompt installation does not prompt you to uninstall any pre-
vious versions of FMEthat are in the same folder. We strongly recommend that you
uninstall any previous FME before silently installing another into the same folder.

Performing an Installation

Example Syntax

Extract the installer to C\FME\installer and install with all
default options
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This examples assumes you are running a command line from a directory that contains
an installer named fme-desktop-win-x64.exe.

fme-desktop-win-x64.exe -d"C:\FME\installer" -s -sp"/gb /norestart
INSTALLLEVEL=3 ENABLE POST INSTALL TASKS=no"

Extract the installer to C\FME\installer and install to C\Pro-
gram Files\FME12345

This examples assumes you are running PowerShell from a directory that contains an
installer named fme-desktop-win-x64.exe.

./fme-desktop-win-x64.exe -d"C:\FME\installer" -s -sp'/gb /nore-
start INSTALLLEVEL=3 ENABLE POST INSTALL TASKS=no INSTALLDIR-

R:" LARARIRININA "C:\Program FileS\FMEl2345" LUARIRIRIRIRIEIN]

Executable Parameters

—-d<path>

Sets the destination folder for unpacked files.

-s, -sl, -s2

Silent mode. Switch - is abrief form of -s1. Both -s and -s1 hide the main dialog and
extraction progress. -s2 hides the start dialog, but extraction progress is displayed.
—-sp<par>

Silent parameters to pass to the extracted MSI installer when it is run. For more inform-
ation, see MSl-Specific Parameters, below.

Note: Quotations must be escaped with eight quotations (see example, above).
Installing from the MSI

Use the following syntax to perform a silent installtion from an MSI that was already
extracted manually from the installer executable.
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Note: You may need to unblock the downloaded .msi file in order to run it. To
unblock afile, usethe unv1ock-ri1e command in the Windows PowerShell utility.
For more information, see https://docs.microsoft.com/en-us/-

powershell/module/microsoft.powershell .utility/unblock-fileAiew=powershell-6.

msiexec /i <path to installer> /gb INSTALLLEVEL=3
INSTALLDIR="<installdir>" ENABLE POST INSTALL TASKS=no

Example:
msiexec /i fme beta.msi /gb INSTALLLEVEL=3 INSTALLDIR="C:\Program

Files\FME" ENABLE POST INSTALL TASKS=no

Note: rnsTaLLLEVEL=3 must always be specified when installing silently from the
command line.

MSI-Specific Parameters

Hags

Note: To view all flags, type nsiexec and hit Enter.
/i <installFile.msi>
Installs the package specified by <installFHle.msi>on your computer.
/qln|b]

Quiet mode. If /b is specified, a dialog with a progress bar displays, but there is no user
interaction. If /qn is specified, no GUI displays.

When /gn is specified, the installer appears to return immediately; however, the install-
ation process continues to run in the background. When installing silently, we recom-
mend enabling logging (see below) so you can check for errors.

/x <installFile.msi>

Uninstalls <installRle.msi>if it is installed on your system.
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/1*v <logfile>

Enables verbose logging of the installation to <logfile>.

Directives

Directives are specified after flags, in the following format:

<directive name>=<directive value>

General Directives

INSTALLLEVEL
If installing with the /o flag, the directive INSTALLLEVH =3 must be specified for the
installation to proceed correctly.

INSTALLDIR

Specifies the full path location of the main installation directory. If the directory does not

exist, it is created. Spaces may be used with quotes.

The default path is C\Program Fles\FME on Windows XP, and C\apps\FME on Windows
Mista and later.

Installer Behavior Directives

The following directives affect the installer's runtime behavior.

ENABLE SOUNDEVENTS

Sets up sound events. Allowed values are yes and no (case-sensitive). Default is yes.
CHECK ADMIN RIGHTS

Checks to ensure that the user installing FME has admin privileges. Allowed values are
yes and no (case-sensitive). Default is yes.

ENABLE SHORTCUTS

Qreates shortcuts in the Windows Start menu. Allowed values are yes and no (case-sens-
itive). Default is yes.
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ENABLE FILETYPE REGISTRATION
Enables FMEapplications to view, open, and work with FMEfiles and GIS data files.
Allowed values are yes and no (case-sensitive). Default is yes.

ENABLE PATH UPDATE

Alows theinstaller to update the PATH environment variable. Allowed values are yes
and no (case-sensitive). Default is yes.

ENABLE STANDARD EXE INSTALLATION

Installs all of the standard FME executables (Data Inspector, Workbench, etc). Allowed
values are yes and no (case-sensitive). Default is yes.

ENABLE LICENSE COPY

Allows the installer to search for old license files, and copy them into the current install-
ation folder if present. Allowed values are yes and no (case-sensitive). Default is yes.
ENABLE POST INSTALL TASKS

Controls whether the license wizard is run after the installer has completed. See also
FMEREG_COMDLINE (below). Allowed values are yes and no (case-sensitive). Default is yes.
FMEREG CMDLINE

Passes values into the license wizard (fmelicensingassistant_cmd.exe) at install time to
automate licensing, using syntax similar to Licensing AVIE Desktop from the Windows

Command Prompt. For example, to license FMEwith a Smallworld license on floating

license server named "license_server", specify FMEREG CMDLINE="--floating license

server smallworld". Forlicense type (FMEedition) values, see Specifying the
FME Edition to Use.

ENABLE ZERO SIDE EFFECT

Sets the following options to "no":
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ENABLE_SOUNDEVENTS, CHECK_ADMIN_RIGHTS,INSTALL_SYSTEM DLLS, ENABLE
SHORTCUTS,ENABLE. FILETYPE REGISTRATION, ENABLE POST INSTALL
TASKS,ENABLE PATH_UPDATEENABLE LICENSE COPY

Allowed values are yes and no (case-sensitive). Default is no.

ENABLE NAD83 NAD27 DATUMSHIFETS

Controls whether implicit NAD27 to NAD83 Datum Transformation is set to USA or
CANADA. Allowed values are yes, no and none. Default is no, which sets this directive to
USA. Ayes setting specifies CANADA only. Specifying none disable the transformation,
which causes workspaces to error when trying to use that shift.

REPORTSTATISTICS

Controls whether statistics about format and transformer use are sent to Safe Software.

Allowed values are yes and no (case-sensitive). Default is yes.

Hle Installation Directives

Some files that are installed by the installer can be omitted by these directives.
INSTALL USER DOCUMENTS

Installs directories to the user's 'Documents' folder, including a'My FMEWbrkspaces'
folder. Default is yes.

INSTALL SYSTEM DLLS

Updates older system DLLs as needed, and run the Microsoft Msual Studio G+ Runtime

Installer. Allowed values are yes and no (case-sensitive). Default is yes.

If set to no, the user is responsible for manually running the G+ Runtime installer, and
ensuring that atl.dll and atl71.dll are installed on the target system. This option is not
recommended, and may lead to non-functional FMEinstallations.

INSTALL THIRDPARTY
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Installs application extenders. Allowed values are yes and no (case-sensitive). Default is
yes.

Enabling application extenders is controlled by the FME Administrator.

INSTALL FMEOBJECTS

Installs FME Objects DLLs and other components. Allowed values are yes and no (case-
sensitive). Default is yes. For more information, see Installing the Software Development

Kit for EME Desktop.

INSTALL GALLERY
Installs the gallery directory. Allowed values are yes and no (case-sensitive). Default is
yes.

INSTALL HELP

Installs the help directory. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL HELP DLL

Installs the help DLLs. Allowed values are yes and no (case-sensitive). Default is yes.
INSTALL METAFILE

Installs the metafile directory. Allowed values are yes and no (case-sensitive). Default is
yes.

INSTALL PLUGINBUILDER

Installs the pluginbuilder directory. Allowed values are yes and no (case-sensitive).
Default is yes.

INSTALL REPROJECT

Installs the Reproject directory. Allowed values are yes and no (case-sensitive). Default is
yes.

INSTALL TCL
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Installs the tcl directory. Allowed values are yes and no (case-sensitive). Default is yes.
INSTALL WORKBENCH EXE

Installs the the AMEWbrkbench application. Allowed values are yes and no (case-sens-
itive). Default is yes.

INSTALL FME EXE

Installs the fmeapplication. Allowed values are yes and no (case-sensitive). Default is yes.
INSTALL FMEADMIN EXE

Installs the AIME Administrator application. Allowed values are yes and no (case-sens-
itive). Default is yes.

INSTALL FMEVIEW EXE

Installs the FME Universal Miewer application. Allowed values are yes and no (case-sens-
itive). Default is yes.

INSTALL FMEGUI EXE

Installs the FME Universal Translator application. Allowed values are yes and no (case-
sensitive). Default is yes.

INSTALL FMEREG EXE

Installs the FME Licensing Assistant application. Allowed values are yes and no (case-
sensitive). Default is yes.

INSTALL WHATSNEW

Installs the what's new/great text files. Allowed values are yes and no (case-sensitive).
Default is yes.

INSTALL FMECOMUTIL DLL

Installs the fmecomutil DLL. Allowed values are yes and no (case-sensitive). Default is
yes.
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INSTALL FME SHELLEXT DLL
Installs the fme shell extension DLL. Allowed values are yes and no (case-sensitive).
Default is yes.

INSTALL SPATIAL ASSISTANT EXE

Installs spatialassistant.exe. Allowed values are yes and no (case-sensitive). Default is
yes.

INSTALL FMEGEOS DLL

Installs geos_fme.dll. Allowed values are yes and no (case-sensitive). Default is yes.

INSTALL PYTHONZ7

Installs a Python 2.7 interpreter. (APython 3.7 interpreter is installed by default.) Allowed
values are yes and no (case-sensitive). Default is no.

WARNING: The Python 2.7 interpreter relies on the Msual Studio 2008 runtime, which
has security vulnerabilities. If you have existing FME Desktop workspaces that ref-
erence Python 2.7, we strongly recommend upgrading them to reference Python 3.xin
lieu of installing the Python 2.7 interpreter.

Post-Install Tasks

Licensing FME Desktop from the Windows Command Prom pt

Bxpand for Details

You can activate an FMEinstallation for a floating license using the following syntax:

fmelicensingassistant —--floating <server>[:<port>] <license type>
For example:
fmelicensingassistant --floating testserver oracle

To get the proper valuesfor <1icense type>,run:
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fmelicensingassistant cmd.exe —--query <server>[:<port>]

For example:

fmelicensingassistant cmd.exe —--query testserver

MSSQL Formats Only

Bxpand for Details

If you plan to run workspaces that reference Microsoft SQL Server and Azure SQL Data-
base (MSSQL_*) readers and writers, you must manually install the OLE DB Driver for
SQL Server and Microsoft System CLR Types for SQL Server. To install, navigate to the
[INSTALLDIR] and run:

msiexec /1 msoledbsgl.msi /gb IACCEPTMSOLEDBSQLLICENSETERMS=YES

msiexec /i SQLSysClrTypes.msi /dgb

Updating to a Newer FME Version

If you are updating to a newer version of FME, follow these steps.

Make sure you back up or relocate any custom files that you have saved in your FME
installation directory.

1. Download and run the new installation file.

2. On the FMEDesktop Installation Extractor dialog, specify a Destination folder in
which to extract installation files. Note that this folder only specifies where install-
ation files are extracted—it does not specify where FME Desktop program files are
installed.

Tip: Take note of the specified Destination folder location. Following install-
ation, you may wish to:

» Review the installation .log file

» Remove these files to save disk space.
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3. dick Install.

4. When extraction is complete, the installer opens. On the Welcome to FME Desktop
screen, click Next.

5. On the Destination Folder dialog, specify a destination folder and click Next.

6. If theinstallation wizard finds a previously installed version of AVEin the specified
destination folder, the installation wizard asks if you would like to uninstall it. If

you answer Yes, click Next. If you answer No, click Back and enter a new des-
tination folder. You can install multiple versions of HVIE Desktop.

7. follow the remaining instructionsin the installation wizard.

Installing FIME Desktop on Linux
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Updating to a Newer FME Version

If you are updating to a newer version of FME Desktop, you must first manually uninstall
the earlier version. Alternatively, you can install to a different directory and have multiple
versions of FME Desktop (see Updating to a Newer RVIE \Version, below).

Make sure you back up or relocate any custom files that you have saved in your FME
installation directory.

Uninstalling

Run the following command, "as root", depending on your Linux distribution:
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o Debian, Ubuntu:

apt remove fme-desktop-<release>

For example:

apt remove fme-desktop-2018
» RedHat, CentOS:

yum remove fme-desktop-<release>

For example:

yum remove fme-desktop-2018

What's Next?
Proceed to Updating Linux.

Updating Linux
To avoid dependency errors, we recommend updating Linux before installing.

Offline Updating and Installation

FMEon Linux requires many third party packages. These dependencies must be satisfied
when FMEis installed. The easiest way to satisfy these dependencies s to install FMEon
acomputer that is connected to the internet, allowing packages to be downloaded as
needed.

It is possible, however, to manually prepare an offline computer for FMEinstallation.

For more information:

o Ubuntu/Debian: Installing packages without an Internet connection

e Red Hat/CentOS: htips://access.redhat.com/solutions/29269

Dependencies can be determined on-demand by using one of the following commands
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o Ubuntu/Debian: dpkg -1 <package name>

o Red Hat/CentOS: yum deplist <package name>

WARNING: If you are accessing local mirrors of public repositories, ensure they match
the version of your Linux.

Debian, Ubuntu

apt update && apt upgrade

RedHat, CentOS

yum update

What's Next?
Proceed to Installing.

Installing

Before installing, be sure to:

1. Review theinstallation Prerequisites.

2. Update Linux.

All installation steps must be performed "as root" (viathe sudo command on some dis-
tributions). FIME Desktop is installed for ALL users.

The install location is /opt/fme-desktop-<release>. (For example, /opt / frme-desktop-
2017.) When complete, the installer generates a configuration (.cfg) file to the install dir-
ectory.

The following installers are available:

Platform Installer Name Example

Debian, fme-desktop-<release> fme-desktop-2017_
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Platform Installer Name Example

Ubuntu <version><build> amd64.deb 2017.0.0.0.17228~ubuntu.18.04 _
amdo64.deb

RedHat, fme-desktop-<release>-<version> fme-desktop-2017-2017.0.0.0-17228.el7 .-
CentOS <build>.x86_64.rpm centos.x86 64.rpm

Downloading the Installer

Download the FME Desktop Installer to your local machine. To obtain the installer, visit

http://www.safe.com/support/downloads.php.

Running the Installer Using the Package Manager

To use the package manager to install FME Desktop and all dependencies, double-click

on the package.

Note: The Debian installation package does not support the Ubuntu Unity package
manager previous to version 16.04.2. Instead, use the command line to install.

Running the Installer Using the Command Line

Run the following commands, depending on your Linux platform, substituting
<release>,<version>and <build>with the corresponding values from your installer
name.

Debian package:
If gdebi is not already installed: zpt install gdebi-core
gdebi fme-desktop-<release> <version>~ubuntu.<build> amd64.deb

RedHat, CentOS package:
yum install fme-desktop-<release>-<version>.el’7.centos.x86 64.rpm

Alternatively, to install to a non-default location, you must first manually install

FME dependencies:
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yum deplist fme-desktop-<release>-<version>.el7.centos.x86 64.rpm

| grep provider | awk '{print $2}' | sort | unig | sed
':a;N;S$!'bay;s/\n/ /g' | xargs yum install -y

Next, run:
rpm -Uvh --relocate /opt=/usr/etc/fme --relocate /us-

r=/usr/fmeicons fme-desktop-<release>-<version>.el7.centos.x86

64.rpm

Each --re10cate argument relocates a prefix to a new location. In the preceding
example, fme installs to /usr/etc/fme/fme-desktop-<release>and the icons, shortcuts,
and others will install to /usr/fmeicons. Note that these arguments are optional, you can
relocate both prefixes, one, or none.

What's Next?
To license FME Desktop, see Licensing.

Multiple Installations of FME Desktop in Parallel

If you want to have multiple of installations of FME Desktop on the same system, we
recommend the following procedure:

1. Install the first copy of FIME Desktop as described in Installing HVIE Desktop on
Linux.

2. Copy the contents of the install directory (/opt/fme-desktop-<release>) to another
location (for example, /home /user/fme-desktop-b18228).

3. Install the second copy of FME Desktop as described in Installing AVIE Desktop on
Linux.

4. Run the first copy of FME Desktop directly from the location to which it was copied
(for example, /home /user/fme-desktop-b18228) - Not from a desktop shortcut.
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You can run the second copy of FME Desktop from a desktop shortcut, which points

to the original install location (fopt/fme-desktop-<release>).

Installing FME Desktop on Mac

1. Double-click the FME Desktop.dmgfile.
2. On the FME Desktop Installer dialog, double-click the FMEicon.
3. Follow theinstructions in the installation wizard.

4. WWhen FMEfinishes installing, the Licensing Assistant starts.

Installing AME Desktop
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Getting Your Current Licensing Status

Installing a Sngle-Hxed License

Asingle-fixed AVEElicense (also known as node-locked or CRClicense) enables RVEto
work on a single specified computer. The FME Licensing Assistant generates a unique
registration key for that computer, which is used to create the license. If FMEis installed
on more than one computer, each computer requires its own license.

Before You Begin

To get your serial number, see the confirmation e-mail you received after purchasing FVIE
Desktop. If you do not know or cannot find your serial number, please send an e-mail to
codes@safe.com to request alicense file.

To activate your license you will need an Internet connection.

Activating a Single-Hxed License

If you have a serial number and an Internet connection, follow these steps to activate a
fixed license from Safe Software.

If you already have a licensed installation, you will be prompted to update it.
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1. Open the FMELicensing Assistant
o On Windows, click the Start menu > Programs > FME Desktop > Utilities > FME
Licensing Assistant.

o On Linux, login as the same user who installed FME Desktop. Navigate to Applic-
ation > FME Desktop > Utilities > FME Licensing Assistant.

« On Mac, /Library/ FME <version>/ Apps/FME Licensing Assistant.

2. The AME Licensing Assistant opens.

3. Select Activate a single-fixed license. Enter the Serial Number in the corresponding
field, and click Activate. To get your serial number, see the confirmation e-mail you
received after purchasing FME Desktop.

Select a Licensing Option

4. dick Fnish.

You will see a confirmation message when FME Desktop is successfully licensed.

Troubleshooting

If you change your system's hardware configuration after installation, or move your
installation to a new system, your license may not work and you will need to enter your
serial number into the licensing assistant as described above.

If you are unable to use the FME Licensing Assistant to activate a license, see Installing a
License Hle Provided by Safe Software.
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Other Licensing Options

« To connect to afloating license server, see Installing a Hoating License Server on

Microsoft Windows.

o To activate atrial version of FME, visit: https://www.safe.com/fme/fme-desktop/trial-

download/

Installing a License Hle Provided by Safe Software

Follow the steps below if you have a problem with the automated license generator. If
this happens, you will need to install alicensefile (= . rme11ic) provided by Safe Software.

For Linux users, you must log in as the same user who installed FME Desktop.

1. Gotothe FMEDesktop License Activation web page (http://www.safe.-

com/activation/).

2. Provide the following:

« Serial number. To get your serial number, see the confirmation e-mail you
received after purchasing FME Desktop.

« Your 10-digit registration key, which is located at the bottom left corner of the
install pane of the AME Desktop Licensing Assistant:

Registration Key: 4-120-151-836 | < Back Activate Cancel

Note: The number shown here is an example only.

3. dick Retrieve License Fle and download the file.

If the previous steps are unsuccessful, you can also send an e-mail message to
codes@safe.com with your serial number and registration key. You will receive an

e-mail message from Safe Software with an attached . rme1ic license file.
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4. Open the AVE Desktop Licensing Assistant (fmelicensingassistant.exe)
o On Windows, the Licensing Assistant is in the Start menu under FME Desktop, or
fmelicensingassistant.exe in the root folder of the AME Desktop install directory.

« On Linux, the Licensing Assistant is in the Applications menu, or in the root
folder of the AIME Desktop install directory.

« On Mac, the Licensing Assistant is in /Library/ FME <version>/ Apps/ FME Licens-
ing Assistant.

5. dick Install alicense file provided by Safe Software.

- o

! -
V < Activate a trial version of FME

= < Install a license file provided by 5afe Software L\\)

Registration Key: < Back Activate Cancel

6. Browse to the location of your license file and click Activate.

%% FME Desktop Licensing Assistant @
Locate License
Enter the location of your license file {*.fmelic).
C:'Licenses'\fme_license, fmelic EI
a s
F'A A Or, if you were sent the license in an e-mail, please copy and paste
v w
the contents here.
Desktop A /
I “-.
=
W = 4
-~
ﬁ Al -
-’y r - 1}
- >
a / »
| =™
-
aare soFTwARE
Registration Key: < Back | [ Activate ] | Cancel

7. dick Anish.

FME Desktop is successfully licensed.
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Licenses are tied to physical properties of systems. If you change your system's hardware
configuration, your FMElicense may not work and you will need to request a new one.

Troubleshooting Single-Fxed Licenses

About the Registration Key

Aregistration key is a unique ID generated from system information by the FME Licensing
Assistant. It is Safe's method of limiting a single-fixed license to a single computer. Safe
needs the registration key from your installation to create a license for FME

In most cases, such as when you are requesting an evaluation license or a new license
for an updated FMEversion, the Licensing Assistant is able to pass the key on to Safe
automatically, allowing us to create a matching license immediately.

However, in some cases, you will need to quote the number to us directly. Some
examples of when this may happen are:

« The connection to the Safe server is not working.

» We need to see the code to help debug alicense problem.

The registration key is shown in the bottom left of the FME Licensing Assistant:
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+# FME Desktop Licensing Assistant u

Select a Licensing Option

@ Activate a single-fixed license 7]

Serial Number: ]

(C) Connect to a floating license server (7]

Server Name: |

2+ Activate a trial version of FME

- # Install a license file provided by Safe Software

I@stration}(ey: - D[ < Back ]| Activate |[ Cancel ]

It can also be found in FIMEWbrkbench or Data Inspector under Help > About... > More

Info.

& FME Information u

General | License Server Status |

FME Information

Edition: FME Desktop Smallworld Edition (floating)
Version: FME(R) 2014 (20140113 - Build 14231 - WING4)
Locale: en_CA

ge: 1252 (ANSI - Lati

Registration Key:

ENSE1)

Serial Number:

Customer Number:

Home Directory: C:\Program Files\FME\,

Operating System: Microsoft Windows 7 64-bit Service Pack 1
(Build 7601)
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Changing Computers

When you move FMEto another computer, you will need a new license, since the new
computer's registration key will not match the one encoded within your existing license.
Ask for a new license by entering your serial number into the AME Licensing Assistant of
the new computer/FAVEinstallation that you wish to license. To get your serial number,
see the confirmation e-mail you received after purchasing FME Desktop.

The new license created on our Safe license server will be for your new registration key.
If you have any issues, contact codes@safe.com.

Virtual Machines

We recommend using a floating license when installing FME on a virtual machine. Safe
Software may not provide updated license files if the registration key of the physical
machine is no longer valid due to frequent hardware changes. For more information, see
About Hoating Licenses.

The Licensing Wizard fails with "Unable to create local license files"
error message

This error indicates the Licensing Assistant was not run as Administrator.

Torun the Licensing Assistant as Administrator

dick Programs > FME Desktop > Utilities, right-click on FME Licensing Assistant, and
select Run as administrator.

It may also help to delete any existing licenses from the directory <AME>\licenses\.
| installed my license but I still cannot run FME Workbench

« Ensure that your machine key matches the key in your license file. Open your license
file at <AME_Dir>\licenses\fme_license.fmelicin atext editor. You will see aline
labeled MACHINE CODE. The code shown here must match exactly your registration
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key shown on the bottom left of the Licensing Assistantl. If they do not match, you
will need to request another license. You cannot edit a license file directly.

« Doesit appear that your license has expired? Ensure you have installed your per-
manent license. If you have not received your permanent license you may need to
request it. Atemporary license may also stop working if you have changed the time
and date settings on your computer, and you will need to contact your account man-
ager to request a new license.

« Do you see amessage, "Duplicate license file.”? This is not an error, and FME should
still run correctly. At times, an unlicensed FMEwill try to contact our licensing server
to seeif thereis alicense available for that serial number. If so, it automatically
licenses itself. This message is caused when you try to manually license FME using
the same license it has already automatically obtained for itself.

» Do you see amessage, "FVE Licensing Notice Your current license is AutoDesk Map.
This application cannot be used with current license..."? You may be using a Training
or CGeneric license. Using your file explorer, navigate to the licenses directory of your
FMEinstallation directory: <AME_Dir>\licenses. Delete every file in this directory
except the file fme_license.fmelic. Restart AIMEWbrkbench or the AME application you
were attempting to use.

» Do you see amessage, "Administrator permissions are required to license FME..."?
The licensing assistant may need to be run with elevated privileges. Aick Programs >
FME Desktop > Utilities, right-click on FME Licensing Assistant, and select Run as
administrator.

« If you have confirmed the machine key matches your license file and still cannot
license FME, or you see error code -500 or -501, in rare cases a registry entry may be
blocking your license. Run regedit and navigate to HKEY LOCAL _

MACHINB SOFTWARR Safe Software Inc.\LICENSE Delete the key called LICENSE
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« Do you see a message, "License quota exceeded..."? Please contact the Technical
Support Team.

» Do you see another message? Please go to https://-
community.safe.com/s/article/troubleshooting.

1To Run the AVE Licensing Assistant go to Start >Programs > FME Desktop > Utilities >
FME Licensing Assistant. In previous versions of FMEthis is also known as the FME Licens-
ing Wizard and may be found in a slightly different location.

FME s licensed but | am still having licensing trouble

« Are you having trouble with a specific format that you cannot see in the format list or
FME cannot read or write to it? Some formats in FMErequire a higher level of licens-
ing, and some formats are provided by 3rd party vendors. Also, some formats require
another application to be installed. In particular, reading/writing ESR Geodatabase
requires a licensed Arc@Sinstallation and GeoMedia Access Warehouse writing
requires a licensed GeoMedia installation. For a complete list of formats and required
helper applications, see hitp://www.safe.com/fme/format-search/. If you would like

to upgrade your FMEto use a specific format, contact your account manager or

sales@safe.com.

« Areyou experiencing another problem? Contact the Technical Support Team. It may
help to ensure that you are, in fact, running afixed license. Please include the FMERe-
port.html file by running the FMETroubleshoot.bat file from the General

Troubleshooting page.

About Hoating Licenses

Afloating license means that a single computer is provided with a number of licenses
and acts as a server by issuing these licenses to any other computer that requests one. A
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floating license is a common way for a company to share a limited number of licenses
among its FME users.

AHexNet software license manager provides the floating license capability to FME The
HexNet software is installed on a computer that acts as a license server. Every time FME
Is started on a computer, the server issues a license, provided there is one still available.
When a computer closes FVE that license is returned. For example, consider a five-seat
floating license and 30 workstation computers. Each workstation has FMEinstalled. Any
workstation can run FME, but only a maximum of five at any one time.

For a full description, visit the Hexera Software website: http://www.flexera.com.

Afloating license serves multiple instances of FME Desktop that are installed locally on
each computer (recommended); or to a single installation on a networked application
server that is accessed remotely by individual users.

Flexera
License
Manager

Flexera
License
Manager

FME
Desktop

FME FME FME

Desktop Desktop Desktop

Machine1 Machine2 Machine3
FME FME FME
User1 User2 User3

Single floating license for FME Single floating license for FME
Desktop installed locally on individual Desktop installed on a networked
computers application server
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Afloating license can serve different FME editions. For example, a floating licenses can
serve both FAME Base Edition and FME Smallworld Edition.

If the expiry dates associated with multiple FMEinstallation serial numbers vary, the
floating license applies the shortest expiry date to all serial numbers.

If you need to transfer an existing floating license to a new license server, you must per-
form a new installation since you still need to request a new license file from Safe Soft-
ware.

To Install a Floating License

 Installing a Hoating License on Windows

o Installing a Hoating License on Linux

Three-Server Redundant Hoating Licenses

The Hexera License Manager allows for redundancy by using a set of three license serv-
ers. With three-server redundancy, the floating license server stays functional, handing
out its total complement of licenses when any two of the three license servers are up
and running.

Amaster server that performs all licensing operations is elected when the redundant
servers are started. The other two servers provide a secure licensing mechanism in the
event of hardware failure or if the master node needs to be rebooted.
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Flexera
License

Flexera Flexera
License }..... License
Manager Manager
MASTER BACKUP

Manager
BACKUP

FME FME FME

Desktop Desktop Desktop
Machine1 Machinez2 Machine3

Permanent Three-Server Redundant
Floating Licenses

It is not arequirement for each of the server nodes to have the same architecture or oper-
ating system, although they should have reliable network communications with each
other and should be on the same subnet. Often, this means that the three servers are loc-

ated physically close to each other.

To Install a Three-Server Redundant Floating License

o Installing a Three-Server Redundant Hoating License Server on Windows

o Installing a Three-Server Redundant Hoating License Server on Linux

Installing a Hoating License on Windows

To install afloating license on Windows, follow these steps:

1. Before You Beqgin

2. Download and Run the Installer

3. Request and Install the License
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4. Install FIMEon dient Computers

5. Start FME Registration

Before You Begin

Ensure that the following requirements are met before beginning the installation:

o You must be running a TCP/IP network.

« One computer on the network is designated as the license server. The license server
may be any computer on the network that is visible to all computers that are depend-
ent on it for their licenses. You should choose a computer that is always running and
always connected to the network because the client computers must be able to com-
municate with the license server to use the FME The processing burden on the licens-
ing server is negligible.

« You must have Administrator privileges to install the FMEHoating License server.

« If the computer you want to use as your floating license server has a firewall, you
must open a port through which the HexServer can communicate. By default, the
range of ports used is 27000-27009, although you can also configure other ports. For
more information, see Specifying Hoating License Server Ports.

« If HexNet is already installed on your license server, you still need to perform a new
installation. FMErequires the version of HexNet that isincluded in the installer. In
addition, if your organization is configuring license borrowing (see Borrowing a Hoat-

ing License), you will require LMTOOLS version 11.8 or newer.

The AVElicense server cannot be installed on a virtual machine that is built and moved
around among many physical machines. It must be locked to a single fixed MAC address.

Licensing 47



Download and Run the Installer

The FMEinstaller contains the utility program required to get the license server up and
running:

o fme-flexnet-win-x86.msi (Wndows 32-bit)

Or

« fme-flexnet-win-x64.msi (\Windows 64-bit)

To download and run

1. Onthe FMEDownloads page, specify the desired version under " Select an
FVE \ersion."

2. Under "Hoating License Installer for FME Desktop," specify the applicable Windows
bit version, and click Download.

3. Onthe computer that acts as the license server, run (double-click) the installer to
create a HexServer directory.

The following table lists the shortcuts that are created in the Safe Software program
group.
Bxpand for details

Shortcut Description

Generate hostid.txt Qreates atext file that contains the
hostname and Host ID information
required when requesting a floating
license from www.safe.-
com/activation/floating/.

Launch LMTOOLS Launches LMTOOLS. Used for
debugging or changing con-
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Shortcut Description
figuration.

License Administration  Opens Hexera Software’s License

Guide Administration Guide.
Start - Restart FME Starts the license manager process.
License Server

View FME License Server Opens the license manager logfile.

Log Used for debugging.

\View hostid.txt Reopens text file, if required by Safe
Software.

View Readme Opens theinstallation and con-

figuration instructions.

Request and Install the License
Perform the following steps on the computer that acts as the license server:

1. dick Start >Programs > HexNet for Safe Software >Mew hostid.txt to open the
hostid.txt file.

If you are installing HexNet on Windows Mista, Windows 7, or Windows 8 and User
Account Control (UACQ) is enabled, right-click Sart-Restart FME License Server and
run this function using administrator privileges. If UACis not enabled, you do not
have to perform this step.

2. Complete the online license request form:

http://www.safe.com/activation/floating/
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You will need a product serial number (for example, BEGP-F7MG-21YL). To get your
serial number, see the confirmation e-mail you received after purchasing FME
Desktop.:

If you do not have a product serial number, e-mail your hostid.txt file to
codes@safe.com.

If you are requesting a combined license and are entering multiple serial numbers,
separate them with commas.

If you do not have hostid.txt and are entering host information manually:

« Hostname isthe name of the computer hosting the floating license.
» Host IDisthe MACaddress (or "Bhernet address") of the host computer (lower-
case, with no colons).
Your hostid.txt may contain multiple Host IDs; however, you can enter only onein
the online request form.
3. You will receive an email with instructions for installing the license:

a. Savethe safellicfile to the HexServer directory. For example: c:\program

Files\FlexServer\

b. Restart the FMELicense Server:

Start Menu > Programs > HexNet for Safe Software> Start - Restart FME
License Server

Install FME on Client Computers

After the license server is running, install FMEon the client computers or on the Network
Server (if you have a fast and non-congested network).

If this is a license upgrade from fixed license to floating license (and not a new RME
installation), then ensure that there are no existing fme 1icense.dat filesin the licenses
directory; for example, check c:\pProgram Files\FME\1licenses and
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C:\Users\<username>\Documents\FME\Licenses. AISO ensure there are no FMEtasks

running before starting the registration process.

Start FME Registration

Perform this step for each computer that has FME installed.

For command prompt instructions, see Licensing FME Desktop from the Windows Com-

mand Prompt.

1. Open the FMELicensing Assistant: Start > Programs > FME Desktop > Utilities > FME
Licensing Assistant.

“* FME Desktop Licensing Assistant

Select a Licensing Option

Reqistration Key:

) Activate a single-fixed license

fn
e

Serial Mumber:

() Connect to a floating license server 2

Server Mame: | licensel

&2 Activate atrial version of FME

O Install a license file provided by Safe Software

< Back [ et >L\\§J [ Canicel ]

2. Select Connect to a floating license server, and enter the name of the computer

that is hosting the FMElicenses.

3. dick the Next button.

4. If your configuration contains more than one type of FMElicense, select the license

that you want to use.

5. dick Fnish to complete the connection.
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Installing a Hoating License on Linux

To install afloating license on Linux, follow these steps:

o o A~ W DN P

Before You Begin

Locate the Hexera License Manager Fles

Ceate a Directory for the Hexera License Manager

Provide the Information to Generate a Hoating License

Install the Hoating License

Configure FME Desktop to Use the Hoating License

Before You Begin

Ensure that the following requirements are met before beginning the installation:

You must be running a TCP/IP network.

One computer on the network is designated as the license server. The license server
may be any computer on the network that is visible to all computers that are depend-
ent on it for their licenses. You should choose a computer that is always running and
always connected to the network because the client computers must be able to com-
municate with the license server to use the AME The processing burden on the licens-
ing server is negligible.

You must have Administrator privileges to install the FMEHoating License server.

If the computer you want to use as your floating license server has afirewall, you
must open a port through which the HexServer can communicate. By default, the
range of ports used is 27000-27009, although you can also configure other ports. For
more information, see Specifying Hoating License Server Ports.

If HexNet is already installed on your license server, you still need to perform a new
installation. FMErequires the version of HexNet that is included in the installer. In
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addition, if your organization is configuring license borrowing (see Borrowing a Hoat-

ing License), you will require LMTOOLS version 11.8 or newer.

The FMElicense server cannot be installed on a virtual machine that is built and moved
around among many physical machines. It must be locked to a single fixed MACaddress.

Locate the Hexera License Manager Files

If you have purchased an FMEfloating or single-fixed license for Linux, copy the
Linux\Flexserver directories from the FMEinstaller. Alternatively, follow these steps:

1. Onthe FMEDownloads page, specify the desired version under Select an
RVIE \ersion.

2. Under Hoating License Installer for AVIE Desktop, select Linux 64-bit and click
Download. This will download the file: fme-flexnet-linux-x64.tar.gz

Create a Directory for the FHexera License Manager

Qreate a directory for the Hexera License Manager on your license server computer,
which is the computer that will manage the licenses. Extract the contents of fme-
flexnet-linux-x64.tar.gz INto thisdirectory. For example:

% mkdir /opt/FlexServer
% cd /opt/FlexServer

% gunzip < ~/fme-flexnet-linux-x64.tar.gz | tar xf -

This directory is referred to as the HexServer directory for the remainder of these instruc-
tions.

Provide the Information to Generate a Hoating License

Safe Software requires three pieces of information to generate a floating or node-locked
license:
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e hostname
e host ID

o FMEserial number

What's Next?

o Install the Hoating License

Obtaining the Hostname

To obtain the hostname, type the hostname command. For example:

% hostname

worf

In this example, the host name isworf.

Determining the Host ID

To determine the host ID, usethe 1mutil 1mhostid command withinthe rilexserver
directory. The output should be an eight-character alphanumeric string (or a 12-char-
acter alphanumeric string on Linux). For example:

% ./lmutil lmhostid
Imutil - Copyright (c) 1989-2009
The FlexNet host ID of this machine is "807abcl2"

In this example, the host IDis 807abc12.

Note: When you arerunning . /1mutil Imhostid,you may see the following error
message:

>-pash: ./lmutil: No such file or directory

This error appears when HexNet is missing necessary libraries to run on Linux. To clear
the error, install 1sb-core by typing the command:

sudo apt install lsb-core
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Determining the FME Serial Number

To get your serial number, see the confirmation e-mail you received after purchasing AVIE
Desktop.

Msit www .safe.com/activation/floating/ and submit the Hoating License Request.

Safe Software will send you afile called sz <. 11 c that contains the key code file for the
license code server.

Copythesafe.1icfileintothe r1exserver directory on your license server computer.

The filename must remain in lowercase text. Safe Software recommends that you do not
change the filename.

Install the Hoating License

To start the Hex Server, you must have a /usr/tmp directory.

\erify that the /usr/tnp directory exists and if it doesn’t exist, create this directory as fol-
lows:

% mkdir /usr/tmp

To start the License Manager:

% <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

This action runs the License Manager in the foreground, logging activity to the terminal.
To storethelogto afileinstead, use the -1 option:

o

% ./lmgrd -c ./safe.lic -1 safe.log

When alogfileis used, 1mgrd detaches as a background process, so there is no need to
explicitly background the application. However, you'll have to start the server each time
the license server host is rebooted. The system administrator can make sure the pre-
ceding command is run at system start-up time.
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Configuring FME Desktop to Use the Floating License

To configure an installation of FMEto use a License Manager, follow these steps.

1. Once RMEDesktop isinstalled on Linux, log in as the same user who installed FME
Desktop.

2. Navigate to Applications > FME Desktop > Utilities > FME Licensing Assistant. The
FME Licensing Assistant opens.

3. Onthe FMELicensing Assistant, select Connect to a floating license server button.

“& FME Desktop Licensing Assistant

Select a Licensing Option

O Activate a single-fixed license (7]

Serial Number:

® Connect to a floating license server 9

Server Mame: (licensel1 |

— Activate a trial version of FME

— Install a license file provided by Safe Software

Help 1-886-400-715 <Back Cancel

4. Inthe Server Name field, enter the name of the license server. dick Next.

5. Select the FMEHlition from the list and click Activate.
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“& FME Desktop Licensing Assistant

Select an Edition

Server: licensel

License Type Seats InUse 63
FME Desktop Intergraph Edition 000 0
FME Desktop Data Interoperability Edition 1000 0
EFME Desktop Professional Edition 2
FME Desktop Base Edition 000 0
FME Data Server for GeoMedia WebMap 1000 0
FME Desktop Microsoft SQL Server Edition 1000 0
v

Click here for a license comparison chart

Help 1-886-400-715 < Back Activate N Cancel

6. dick FAnish.

“% FME Desktop Licensing Assistant

License Summary

You now have the following licenses:

FME Desktop Professional Edition (floating on license1)

For information, tools, and news you need to help build your FME expertise, visit
knowledge. safe.com.

Help 1-886-400-715 < Back Cancel

Afloating license isinstalled to borrow alicense.

Installing a Three-Server Redundant Hoating
License Server on Windows

To install Three-Server Redundant Hoating Licenses on Windows:
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Before You Begin

Download and Run the Installer

Start the License Servers

Install FIME On dient Computers

o~ W N P

Start FME Reqistration

Before You Begin

Ensure that the following requirements are met before beginning the installation:

« You must be running a TCP/IP network.

« Three computers on the network are designated as license servers. The license serv-
ers may be any computers on the network that are visible to all computers that may
dependent on them for their licenses. You should choose computers that are always
running and always connected to the network because the client computers must be
able to communicate with any one license server to use FME The processing burden
on the licensing server is negligible.

» You must have Administrator privileges to install the Hexera Licensing Manager.

« If the computers you want to use as your floating license servers have firewalls, you
must open a port on each one through which the HexServer can communicate. By
default, the range of ports used is 27000-27009, although you can also configure
other ports.

« If HexNet is already installed on your license servers, you still need to perform a new
installation. FMErequires the version of HexNet that isincluded in the installer. In
addition, if your organization is configuring license borrowing (see Borrowing a Hoat-

ing License), you will require LMTOOLS version 11.8 or newer.

The FVElicense servers cannot be installed on a virtual machine that is built and moved
around among many physical machines. It must be locked to a single fixed MACaddress.
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Download and Run the Installer (Three-Server Redundant Floating
License Server)

The FMEinstaller contains the utility program that is needed to get the license server up

and running:

fme-flexnet-win-x86.msi

or

fme-flexnet-win-x64.msi

To download and run

1. Onthe FMEDownloads page, specify the desired version under " Select an
FME \ersion."

2. Under "Hoating License Installer for FME Desktop," specify the applicable Windows
bit version, and click Download.

Note: If you are viewing this link in a PDFfile, your Acrobat security settings
may prevent access to the installer. Instead, paste https: //wuw.safe. -
com/support/downloads/ Into aweb browser.

3. On each computer that acts as a license server, run (double-click) the installer to
create a HexServer directory.

4. Send an e-mail to codes@safe.com and include the HexNet Host ID, the hostname
assigned to each of the computers, and serial number. To get your serial number,
see the confirmation e-mail you received after purchasing AME Desktop.

The table that follows lists the shortcuts that are created in the Safe Software pro-

gram group:

Bxpand for details
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Shortcut Description

Generate hostid.txt Qeates atext fileto send to
codes@safe.com.

Launch LMTOOLS Launches LMTOOLS. Used for debug-
ging or changing configuration.

License Administration Opens Hexera Software’s License

Guide Administration Guide.

Start - Restart FMELicense Starts the license manager process.
Server

\View FME License Server Opens the license manager log file.

Log Used for debugging.

View hostid.txt Reopens text file, if required by Safe
Software.

\View Readme Openstheinstallation and con-

figuration instructions.

5. We will e-mail you afile called s=r<.1ic that contains the key code file for the
license code servers. Copythe safe. 1ic fileinto each of the r1exserver directories

on your license server nodes.

Start the License Servers

On all three servers, start the license manager. Go to Start > Programs > Safe Software,
and run Start - Restart FME License Server.

If you're installing HexNet on Windows Msta, right-click Sart-Restart AME License Server
and run this function using administrator privileges.

Thefirst server started of the first two serverslisted inthe fme 1icense.dat file
becomes the master node.
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Start the servers in the order shown in the following example:

SERVER hostl 1223344 27009
SERVER host2 9384749 27009
SERVER host3 2038404 27009
VENDOR safe
FEATURE FME

Therefore, the first server to start—o0st 1—becomes the master node; host3 never
becomes the master node.

There is no time limit for starting all of the servers.

Unlike independent servers, each server line requires a port number. The port number
in this exampleis 27009. You can modify the port numbers to any unused port number in
therange 1024 to 32000.

You can change the order of the servER lines to suggest which node is the master node,
however we recommend you keep the order shown in the preceding example.

Install FME on Client Computers

When the server license files are running, install FME on the client computers or on the
Network Server (if you have a fast and uncongested network). If thisis not a new install
(but rather alicense upgrade from fixed license to floating), ensure that there are no exist-
INg fme license.dat OF fme license.fmelicfilesinthec:\program Files\FME\11-

censes directory.

Using atext editor, create afile called fme 1icense.dat that contains the same three
servER linesfromthe sare. 1ic filesthat were used to start the redundant server
nodes. Add ause server line after the server lines, as shown in the following example:

SERVER hostl 1223344 27009
SERVER host2 9384749 27009
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SERVER host3 2038404 27009
USE_SERVER

Place this fme 1icense.dat filein the FMEclient installation licenses directory; that is, in

thec:\prrogram Files\FME\licenses directory.

Start FME Registration

Perform this step for each computer that has FME installed.

For command prompt instructions, see Licensing FME Desktop from the Windows Com-

mand Prompt.

1. Open the FMELicensing Assistant: Start > Programs > FME Desktop > Utilities > FME
Licensing Assistant.

“% FME Desktop Licensing Assistant

Select a Licensing Option

(0 Activate a single-fixed license (7]

Serial Mumber:

(® Connect to a floating license server (7]

Server Name: |licensel |

— Activate a trial version of FME

— Install a license file provided by Safe Software

Help 1-886-400-715 < Back Cancel

2. Select Connect to a floating license server, and enter the name of the master node

computer that is hosting the license.
3. dick the Next button.
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4. If your configuration contains more than one type of FMElicense, select the license
that you want to use.

5. dick Fnish to complete the connection.

Installing a Three-Server Redundant Hoating
License Server on Linux

To install Three-Server Redundant Hoating Licenses on Linux:

1. Before You Beqgin

2. Download and Run the Installer

3. Start the License Servers

4. Run the AVEELicensing Assistant and Connect to the Frst Server

Before You Begin

Ensure that the following requirements are met before beginning the installation:

« You must be running a TCP/IP network.

« Three computers on the network are designated as license servers. The license serv-
ers may be any computers on the network that are visible to all computers that may
dependent on them for their licenses. You should choose computers that are always
running and always connected to the network because the client computers must be
able to communicate with any one license server to use FME The processing burden
on the licensing server is negligible.

« You must have Administrator privileges to install the Hexera Licensing Manager.

« If the computers you want to use as your floating license servers have firewalls, you
must open a port on each one through which the HexServer can communicate. By
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default, the range of ports used is 27000-27009, although you can also configure
other ports.

« If HexNet is already installed on your license servers, you still need to perform a new

installation. FMErequires the version of HexNet that is included in the installer. In

addition, if your organization is configuring license borrowing (see Borrowing a Hoat-

ing License), you will require LMTOOLS version 11.8 or newer.

The FMElicense servers cannot be installed on a virtual machine that is built and moved

around among many physical machines. It must be locked to a single fixed MACaddress.

Download and Run the Installer

Install the floating license server on three different computers using the instructionsin
sections Before You Begin through Installing a New Hoating License.

Send an e-mail to codes@safe.com and include the HexNet Host ID, the hostname
assigned to each of the computers, and serial number. To get your serial number, see
the confirmation e-mail you received after purchasing FME Desktop.

We will e-mail you afile called s=r<. 1ic that contains the key code file for the license
code servers. Copy the safe. 1ic fileinto each of the r1exserver directories on your
license server nodes.

Start the License Servers
Start the license manager on all three servers, in order based on the following:

The first server started of the first two serverslisted inthe fme 1icense.dat file
becomes the master node.

Start the servers in the order shown in the following example:

SERVER hostl 1223344 27009
SERVER host2 9384749 27009
SERVER host3 2038404 27009
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VENDOR safe
FEATURE FME

Therefore, the first server to start—.o0st 1—becomes the master node; host3 never
becomes the master node.

There is no time limit for starting all of the servers.

Unlike independent servers, each server line requires a port number. The port number
in this exampleis 27009. You can modify the port numbers to any unused port number in
therange 1024 to 32000.

You can change the order of the servER lines to suggest which node is the master node,
however we recommend you keep the order shown in the preceding example.

To start the License Manager:

% <FlexServerDir>/lmgrd -c <FLEXServerDir>/safe.lic

This action runs the License Manager in the foreground, logging activity to the terminal.
To storethelogto afileinstead, use the -1 option:

o

% ./lmgrd -c ./safe.lic -1 safe.log

When alogfileis used, 1mgrd detaches as a background process, so there is no need to
explicitly background the application. However, you'll have to start the server each time
the license server host is rebooted. The system administrator can make sure the pre-
ceding command is run at system start-up time.

Configuring FME Desktop to Use the Hoating License

To configure an installation of FIMEto use a License Manager, follow these steps.

1. Once FMEDesktop isinstalled on Linux, login as the same user who installed FME
Desktop.
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2. Navigate to Applications > FME Desktop > Utilities > FME Licensing Assistant. The
FME Licensing Assistant opens.

3. Onthe FMELicensing Assistant, select Connect to a floating license server button.

“& FME Desktop Licensing Assistant

Select a Licensing Option

() Activate a single-fixed license 9

Serial Number:

(®) Connect to a floating license server e

Server Mame: [license1 |

— Activate a trial version of FME

— Install a license file provided by Safe Software

Help 1-886-400-715 < Back Cancel

4. In the Server Name field, enter the name of the master node computer that is host-

ing the license. Aick Next.
5. Select the FME Hition from the list and click Activate.

“§ FME Desktop Licensing Assistant

Select an Edition

Server: licensel

License Type Seats InUse ()
FME Desktop Intergraph Edition 000 0
FME Desktop Data Interoperability Edition 1000 0

EFME Desktop Professional Edition : 2
FME Desktop Base Edition 00 0
FME Data Server for GeoMedia WebMap 1000 0
FME Desktop Microsoft SOL Server Edition 1000 0

CRAC OO A I c i 4 runn,

Click here for a license comparison chart

Help 1-886-400-715 < Back Activate k Cancel
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6. dick Anish.

“ FME Desktop Licensing Assistant

License Summary

You now have the following licenses:

FME Desktop Professional Edition (floating on license 1)

For information, tools, and news you need to help build your FME expertise, visit
knowledge. safe.com.

Help 1-886-400-715 = Back Cancel

Afloating licenseisinstalled to borrow alicense.

Monitoring Hoating License Use

To find out who is currently using FME licenses from your floating license pool:

1. Ensure the Hexeralicense manager utility (Imutil) is installed. Thistool is installed
with the floating license manager, available on the FME Downloads site
(http://www.safe.com/support/support-resources/fme-downloads/). On Windows,

it isinstalled by default in C\Program FHles\HexServer.

2. Oreate a"license file" that you will use on your computer. You can call it safe.lic, or
any other name endingin .lic. It should contain the following:

SERVER <IP address or name of license server> Any [optional

port number]

for example:

SERVER 107.22.68.36 Any

or
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SERVER licensel Any 27000

You can use either the IP address or the name of the floating license server. We
recommend using the server name because the IP address might change.

any IS required because the license server query requires both the host name and
host id. 2ny can be used as the hostid. If known, you can also use the MACaddress
of the license server.

The port number is generally between 27000 and 27009. If you do not know what
port is being used for the Safe floating license server, leave this blank, and Imutil

will find it automatically. If you do specify the port, the 1mstat queryis much
faster.

3. Open a Command Window

Use the safe.licfile to query all details using the command:

Imutil Imstat —-a —-c <license file>

for example:

Imutil Imstat -a -c safe.lic

Thiswill return alot of information. You may want to query for specific features in
the license file. You can do this using acommand like:

Imutil lmstat -f FME -c safe.lic

The - flag specifies the feature you want reported. If you want to know who has

checked out any FMEfeature, use - ruve. You can also look for specific license
types like smallworld, oracle, esri, professional, base, and server.

If you do not specify alicensefile, imutil 1mstat will query all filesin its folder end-
ing in .lic. This can be useful if you have multiple floating license servers; you can
guery all of them at once by having a separate .lic file for each, and then omitting
the-cflaginthe imuti1 command.
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Interpreting the output of the Imstat query

The output of 1mstat -a looks similar to:

Imstat - Copyright (c) 1989-2012 Flexera SoftwareLLC. All Rights
Reserved. Flexible License Manager status on Wed 02/28/2012 14:49
[Detecting lmgrd processes...]

License server status: 40000@prod

License file(s) on prod: C:\prod\i86 n3\counted.lic:

prod: license server UP v11.5

Feature usage info:

Users of fl: (Total of 4 licenses issued; Total of 1 license in
use)

"f1" v1.0, vendor: demo

floating license

daniel myhost2 19.36.18.26 (v1.0) (myhostl1/40000 102), start Fri
2/28 14:29

where:

Output Argument Description

daniel user User name.

myhost2 user_host Host where user is running.

19.36.18.26 display Display where user is running.

v10 version \ersion of feature.

myhost1 server_host Host where license server is running.

40000 port TCP/IP port on server_host where license server is run-
ning.

102 handle License handle.

start Fri 2/28 checkout Timethat this license was checked out.
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Qutput Argument Description
14:29 time

For more information about using the Imutil 1msta+ command, see the "License Admin-

Istration Guide" under "Documentation,” on the Hexera downloads page, at http://www.-
globes.com/support/fnp utilities download.htm.

Specifying Hoating License Server Ports

This topic explains how to specify ports used by the floating license server. By default,
communication between the floating license server and a client running FMEoccurs on a
random port. Specifying ports can be useful in specific security configurations. For
example, if you have afirewall between your floating license server and a client machine
running FME, you may want to open a specific port for this communication. Or, you may
wish to avoid conflict when multiple HexNet servers are installed in the same envir-
onment. For example, FMEmay use a random port, but ArcGS may use a fixed port, and
a conflict will occur if the same port isin use.

To specify FHoating License Server Ports

Edit the safe.lic file in your HexServer directory so that vy onthe venpor lineisthe
port you want to open for the communication to the client machine running FME The
port inthe servER line (xxxx) can also be set, but thisis necessary only for athree-
server redundant configuration, or if another HexNet license server is using a specific

port.

SERVER servername 000c290deO0df xxxx
VENDOR safe PORT=yyyy

The port number for the SERVERand the VENDOR must be different. On Windows, the
VENDOR port is typically between 1024 and 65535. On Linux, the default VENDOR port is
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between 32768 and 61000. The SERVER port is typically between 27000 and 27009. Be
sure to add the VENDOR port and SERVER port to your firewall exceptions.

If the VENDOR port is specified, the FMErunning on the client machine must specify this
port as well. Using the AVE Licensing Assistant, specify the port number when prompted
to "Connect to a Hoating License Server," as shown below:

LicenseServerName:yyyy
where vyvy isthe port number used in the VENDORIine of the safe.licfile.

In earlier releases of AVE, the fme_license.dat file in the <FMBEDir>\licenses\ directory
must be edited manually. It should contain the following line:

SERVER LicenseServerName Any yyyy
where vyvy isthe port number used in the VENDORIine of the safe.lic file.
Fnally, restart the FME License Server:

o Windows: Start Menu > Programs > HexNet for Safe Software> Start - Restart AVE
License Server

e Linux: s <FlexServerDir>/Imgrd -c <FLEXServerDir>/safe.lic

Borrowing a Hoating License

If your FME Desktop product uses a floating license, and your organization supports this
option, you can borrow a license for offline use.

Afixed license configuration does not allow you to borrow a license. In addition to afloat-
ing license, you need a floating license server with the license borrowing capabilities
enabled.

License borrowing requires LMTOOLS version 11.8 or newer.
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If alicense is available, you can borrow it and run FMEfor the maximum period, as spe-
cified in your license file, on a computer that will not be connected to the license server.
The default period is 30 days.

If a different license period than the default is required, ask your System Administrator to
contact us at codes@safe.com.

When the borrowing period expires, the license also expires. After the expiry date, the
license automatically becomes available for other users to borrow.

You do not have to return the license after an expiry date; however, you can choose to
return alicense early. See Return the License.

test

testtesttest

To Borrow a Floating License

1. Connect to the Hoating License

2. Specify the Terms of the License

To Return a Borrowed License

¢ Return the License

Connect to the Hoating License Server

To borrow alicense, you first need to connect to afloating license server. (Please see
your System Administrator if you do not know the server name.)

1. Open the FME Desktop Licensing Assistant by clicking Start > Programs > FME
Desktop > Utilities > AME Licensing Assistant.
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2. Select Connect to a floating license server. In the Server Name field, enter the

name of the floating license server.

3. dick Next.

“* FME Desktop Licensing Assistant

Select a Licensing Option

(O Activate a single-fixed license

L e

Serial Mumber:

(®) Connect to a floating license server

L &

Server Mame: | licensel

@) Activate atrial version of FME

- @ Install a license file provided by Safe Software

< Back [ et >kj [ Canicel ]

Reqistration Key:

4. Select the license type from the list, and click Activate.

“* FME Desktop Licensing Assistant

Select an Edition

Server; Licensed

License Type Seats  In Use

ssional Edition : 5 a

SarE RorTwane Click here For a license comparison chart

Registration Key: [ < Back ] n%'vate l[ Cancel

5. dick Anish.
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You will see a message when you are successfully connected to the floating license
server.

To borrow the license for offline use, you will have to start FMEWorkbench and spe-
cify the terms of the license. See Specify the Terms of the License.

Specify the Terms of the License

To access the License Borrowing option, start FMEWorkbench:

1. Qick Start >Programs > FME Desktop >FMEWorkbench.
2. dick Tools > License Borrowing.

3. Qick Yes, borrow a license for, and then enter or adjust the number of days. Qick
OKto close the dialog.

%F License Borrowing

Status: Not Borrowed

‘Wwhen using a floating license, a license may be temporarily borrowed From the
licensing server. This allows FME to run even when disconnected From the
licensing server.

Wwould you like to borrow a license?

(¥ ves, borrow a license for |F 5| dayi(s)

) Mo, don't borrow a license

% Caniel
4. dick OK.

“¢ License Borrowing g|

\i) The license was successfully borrowed,

-

You have successfully borrowed the floating license for the specified number of

days.

To run FME Desktop during this time frame, you do not need to be connected to the
license server.
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Return the License

To return aborrowed license before the time expires:

1. Start Workbench.
2. dick Tools > License Borrowing.

3. On the License Borrowing pane, select Yes, return the borrowed license early. Qick
OK.

4. dick OKto close the dialog.

The license is now available for other FME Desktop users to borrow.

You cannot change or update licenses when you have borrowed a floating license.
You must first return a borrowed license.

Restricting Licenses to Users or Groups

You can restrict floating licenses to specific users, groups, or machines. Create a file
called safe.opt in the HexServer directory. There is no need to reference thisfile in any
other configuration files; HexNet knows to look for it automatically. However, the file
must be named safe.opt, and it must be in the same folder as sate . exe.

Any licenses reserved for a user are dedicated to that user. BEven when that user is not act-
ively using the license, it is unavailable to other users.
Here is an example of an optionsfile:

RESERVE 1 professional GROUP groupA
GROUP groupA xxXxxX YVVV
RESERVE 1 professional GROUP groupB

GROUP groupB aaaa
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This example reserves one FME Desktop Professional license for users xxxx and yyyy,
who are in group groupA, and one Professional license for user aaaa, who is in group
groupB. GROUP member names are case-sensitive.

To restrict alicense to specific hosts (i.e. machines) instead, replace the keyword GROUP
with HOST_GROUP.

For more documentation, including additional options, see <HexServer>\Docu-
ments\LicenseAdministration.pdf, where <HexServer>is the directory where you
installed the HexNet software.

Troubleshooting Hoating Licenses

Specifying the FME Edition to Use

If your floating license service supports multiple editions of FME, you can use the flexim_
config.dat file to tell FIMEwhat edition to use.

To determine the FME editions you are licensed for, consult the safe.lic file on your
license server.

To specify the FME Edition to Use

On the computer that is running FME Desktop, edit (or create) flexlm_config.dat in the
<FMBEDir>\licenses\ folder.

The contents should be the following two lines:

Registered Product=<FME edition name>

<Displayed name in FME>

For example:

Registered Product=smallworld

FME Desktop Smallworld Edition
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<FME edition name> IS Case-sensitive. <pisplayed name in FME> appears when you
navigate to Help > About in FIMEWorkbench or FME Data Inspector.

Possible values for FME Edition Name are:

FME Edition Name Displayed Name in FME

professional FME Desktop Professional Edition
esfi FME Desktop ESRI Edition
database FME Desktop Database Edition
smallworld FME Desktop Smallworld Edition

System error 1067 has occurred

Symptoms
The following error occurs following an attempt to start the license server:

system error 1067 has occurred

Cause

This error can occur if you were provided an invalid license file.

Resolution

Open the safe.lic file that you saved to your HexServer directory. (For example: c:\pro-
gram Files\Flexserver\.) |t should contain a number of lines starting with 'FEATURE.
If the file only has the following contents, then it is invalid:

SERVER 0022fb821528 skyfire
VENDOR safe
USEiSERVER

Send your hostid.txt (Start > Programs >HexNet for Safe Software >Mew hostid.txt) and
safe.lic files to codes@safe.com and mention that the license file is empty. Anew license
file will be generated for you.
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The License Server will not Start on Linux
The HexNet license server fails on Linux
Symptoms

On the client machine, the error message is:

....License system failure. Check that the safe daemon version is

newer than the FME client version. Program Terminating.

On the license server, the error message is:

./1lmgrd -c ./safe.lic -1 safe.log

>-pbash: ./lmgrd: No such file or directory
Cause

HexNet is missing necessary libraries to run on Linux
Resolution

On the license server, install 1sb-coreby typing the following command in the Linux ter-
minal:

sudo apt install lsb-core

Access to Hoating License Times Out Over VPN

Access to the HexNet floating license over a virtual private network (VPN) may time out if
the network is slow. To minimize this issue, set the FLEXLM_TIMEOUT environment vari-
able.

1. Open the Windows System Properties dialog (Start > Control Panel > System >
Advanced System Settings.

2. On the Advanced tab, click Environment Variables.
3. Under System Variables, click New.
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4. Inthe Variable name box, enter: FLEXLM TIMEOUT
5. Inthe Variable value box, enter: 1000000
6. dick OKto close each dialog box.

Licensing from the Linux Command Line

To activate a single-fixed license with your serial number

e Run:

./fmelicensingassistant --serial <serial-number>

To get your serial number, see the confirmation e-mail you received after purchasing FME
Desktop.

To activate a single-fixed license with a trial code

1. Goto https://www.safe.com/trial-code/ to generate atrial code.

2. Run:

./fmelicensingassistant --trial <trial-license-code>

To activate a license file provided by Safe Software

1. Complete steps 1-3 under Installing a License Hle Provided by Safe Software.

Note: To obtain the registration key, navigate to the FME Desktop installation
folder and run:

./fmelicensingassistant --key

2. Run:

./fmelicensingassistant --file <filename>
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To configure FME Desktop to use a floating license

1. Complete steps 1-5under Installing a Hoating License on Linux.

2. Run:

./fmelicensingassistant --floating <server>|[:<port>] <FME-Edi-

tion>

Note: For information about specifying < FvE-Edi t 1 on>, see Specifying the
FME Edition to Use.

To configure FME Desktop to use a three-server redundant float-

ing license

1. Complete steps 1-3 under Installing a Three-Server Redundant Hoating License

Server on Linux

2. Run:

./fmelicensingassistant --floating <master-node-server>

[ :<port>] <FME-Edition>

Note: For information about specifying < FvE-Edi t 1 on>, see Specifying the
FME Edition to Use.

Getting Your Current Licensing Status

To find out the current licensing status of your FME Desktop installation, open the FME

Licensing Assistant. In Windows:
Start > All Programs > FME Desktop > Utilities > AME Licensing Assistant

The Licensing Assistant opens and displays the current licensing status. For example:
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£3 FME Desktop Licensing Assistant

Update License

You currently have the following licenses:

FME Desktop Smallworld Edition {floating on LICENSE 1)

To update your license, dick Mext,

Next > Finish

Cancel

See Also

o About the Reqistration Key
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Other Common Tasks

Installing the Software Development Kit for FME
Desktop

The FME Desktop installer allows the option of installing the Software Development Kit
(SDK) for AME Desktop. The SDK provides access to the FME Objects and FMEPlug-in
Builder APIs. You can use the APIs to create your own applications and plug-ins that

make use of FMEfunctionality.

Installing Grid Shift RHles

FME supports conversions between coordinate systems using different datums. Many
datum transformations are not mathematically definable and require the use of grid of
shifts. If you attempt to perform a datum transformation of this kind without the appro-
priate grid shift file in place, FME stops the translation.

Installing Grid Shift Hles on Windows

When you install FME for Windows, the grid shift files provided by Safe Software are auto-
matically installed in the correct location.

If you have already installed AVE, you can find more information on which files are
included by opening Workbench help and clicking on the Coordinate Systems topic, or
by choosing Tools > Browse Coordinate Systems and pressing the F1 key.

You can manage grid shift files by choosing Tools > FME Options > Coordinate Systems.

dick the Help button for more information on how you can maintain grid shift files.
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Installing Grid Shift Hles on Linux

When you install FMEfor Linux, the grid shift files provided by Safe Software are auto-
matically installed in the correct locations.

You can find more information on which files are included in Linux and UNIXinstallations
by viewing our FME AME Community site:

FME Knowledge Center.com/index.php/Datum Transformations and Grid

Shift_Files

The files in the Reproject subdirectory of your FMEinstallation folder include a path to
the location of your grid file. The order in which the grids are listed is the order in which
FME uses them.

To register afile, add the full pathname of the file to the beginning of the appropriate

.gdc file. For example, in n2d27ToNad8 3. gdc, add:

fmehome\Reproject\GridData\Canada\NTV2 0.gsb

To make sure the files were registered correctly, check the log file when you run atrans-
lation.

If you have access to the FIMEWorkbench user interface, you can manage grid shift files
through the Workbench > Tools > RME Options menu. Aick the Coordinate Systems icon.

Using AIME Desktop with Third-Party Applic-
ations

FME Desktop integrates with a number of popular GS applications. sit www.safe.com
for more information.

This section provides instructions for using the FME Integration Console to extend any
applicable third-party applications.
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About the FME Integration Console

FME Application Extensions are products that use or embed FMEfunctionality in other
applications. The exact functionality varies from product to product, but can include the
ability to read datasets not native to that application, to export to non-native datasets,
or to convert between two non-native formats.

FMEcan "extend " several different applications. Some extensions are packaged as part
of FME, some are sold as add-ons, and some are packaged as part of the other GS applic-
ation. Unless they are packaged as part of FME, support for Application Extensions is usu-
ally provided by the application vendor.

For information about how FMEworks with other applications, please see Solutions for
G S Applications.

Note: FMEdoes not currently extend any applications on Mac or Linux.

Installation Notes
When extending an application using FME Desktop, please be aware of the following:
« 64-bit and 32-bit applications can only be extended with the 64-bit and 32-bit ver-

sions of AVIE, respectively.

« Fixed (node-locked) licenses of FME Desktop will automatically extend compatible
third-party software installed on the same system. You can easily revert the exten-

sions.

« FMEcannot extend shared applications that are installed on a different machine. FME
and the application to be extended must be installed on the same logical machine,
whether it is a physical machine or a virtual machine.

Using the Integration Console

Bxtending Applications
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Menus and Windows

Reverting Applications

Troubleshooting

Integration Console Menus and Windows

The FHle and Mfew menus contain basic window-level commands that allow you close
the application or adjust the visible areas.

Through the Help menu, you can view the current FMEbuild number, and check for
FMEupdates.

Log Pane

The log pane shows status information and results.

Log B X

Scanning for extenders...
Found FME Extension for ArcGIS.
Found 1 available extender(s).

| nding FM ion for ArcGIS...
Extend successiul.

Properties Pane

dick on the name of the application to display its Properties:

Property Value
Application The name of the application.
Status The FMEDbuild number that extends
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Property

Extendable

BExtended

FME Build

FMEHome Path

Buttons

Copy Text

Options

Other Common Tasks

Value

the application. The build number
will change each time you update
FVE

Is this application extendable by
FME? A Yes in this column indicates
that the application is ready to be
extended.

Is this application extended by FME?
If No, then you can extend the
application from the Action column.

The current FMEDbuild installed on
your machine.

The location of the AMEinstallation
folder.

Copies the properties so you can
paste details into an e-mail applic-
ation or text file. This information
might be required if you need to
troubleshoot an installation.

This button is enabled only when
certain third-party applications are
installed.

When it is enabled, you can set
application-specific top-level
defaults.

86



Extending Applications

After installing FME Desktop, open the Windows Start menu, and click the Programs (or
All Programs) submenu. dick FME Desktop > Utilities > FME Integration Console.

Note: To ensure that you do not encounter any integration issues, we recommend
that you run the Integration Console with Administrator privileges. To do this, right-
click on the Integration Console menu entry, and select Run as administrator, as
shown here:

FME Desktop

@ FME Data Inspector
&2 FME Workbench

Documentation

0
| Utilities e
) T
4 FME Integration Conscle % Run as administrator
2 FME Licensing Assistant Troubleshoot compatibility

ﬂ FME Quick Translator
45 FME Universal Viewer

When the FME Integration Console starts, click the Extend button next to the application.
(Note that the application must be closed.)

FMEwill scan your machine for any installed applications that can be extended to sup-
port FME The results appear in the Application column.

If the status of an application is Not Extended, the Action column will show an Extend
button. Press the button to extend the application. The log pane will display inform-
ation.
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> FME Integration Console

File View Help
Application Status
FME Extension for ArcGIS Mot Extended

Log

Scanning for extenders...

Found 1 availabkle extender(3).

Found FME Extension for ArciIS.

& X Properties

Property Value

Copy Text Options...

FME Smallworld Edition (node locked-crc) -- (20110820 - Build €

The Log will display the message Extend Successful.

Note: Open the extended application to ensure that FIME has been successfully
extended from within that application. In the example above, FMEis extended with

FME Extension for ArcGIS. To check this extension, open the Extensions window from
ArcCatalog or ArcMap (from the Qustomize > Extensions menu in ArcAS 10.x) and

ensure that FIME Extension for ArcGS s selected.

Menus and Windows

Troubleshooting

Reverting Applications

Other Common Tasks
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Reverting Applications

If the Status of an application is Extended, the Action column will contain a Revert but-
ton.

Action

Hy Revert

Note: Ensure that the extended application is closed.

Press the button to revert the application to a Not Extended state.
The log pane will display status information.

Extending Applications

Troubleshooting

Troubleshooting

Always make sure an application is closed before extending or reverting it in the
FME Integration Console.

If an application status does not show Extended:

» Ensurethat you have the correct license for extending the application. Training
licenses will not work.

« Ensurethat you are using the correct architecture version of AME Desktop for the
application you are trying to extend. For example, AutoCAD Map 3D s only available
in a 64-bit version, and therefore must be extended using 64-bit FIME Desktop.

» Ensure that you have the correct license for extending the application. Training
licenses will not work.
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